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1. Orthopaedic Studio - Instructions for usage

1.1 Introduction

Orthopaedic Studio is a plugin for OsiriX, designed to help orthopaedic specialists perform a number 
of common quantitative hip examinations based on standard radiograph images. 

Orthopaedic Studio is designed for ease of use. The user identifies landmarks in the radiograph 
images, according to the self-explanatory instructions and illustrations which are shown at each step 
of the process. From these landmarks Orthopaedic Studio automatically calculates all angles, 
measurement and offsets that are of interest in the image. The final results can be directly exported 
into Excel compatible files.

1.2 Installation

Orthopaedic Studio can be downloaded and installed using the built-in ‘Plugins manager’ in OsiriX, 
which is found in the Plugins menu. Click on the downloads tab and then select to download and 
install Orthopaedic Studio.

Orthopaedic Studio can also be downloaded from our website (http://orthostudio.spectronic.se/).

1.3 General Usage

Orthopaedic Studio can do hip evaluations on four different types of radiograph images: 
Anteroposterior (AP), Von Rosen, False Profile and Frog.

The procedure is self-explanatory and very similar for all types of images. The example below 
describes how to evaluate an AP image:

1. First open the AP image to be evaluated in OsiriX. 
2. Start Orthopaedic Studio by selecting ‘Anteroposterior’ from the Orthopaedic Studio sub menu. 
 (Plugins -> ROI Tools -> Orthopaedic Studio -> Anteroposterior).
3. Select the appropriate visual scores for the current image. Then click the ‘Set markers’ button.
4. Place markers to identify landmarks within the image, in accordance with the on-screen 

instructions. Note that the markers can be moved after being placed. When all markers are placed, 
click the ‘Results’ button.

5. Review the results and perform changes if necessary.
6. Click on any of the save buttons to save the data to an Excel compatible file.
 

The other types of evaluations (i.e. Von Rosen, False Profile or Frog) are performed according to 
similar schemes. Substitute ’AP’ for any of the other evaluation types in steps 1 and 2 above and 
follow the on-screen instructions.

Note that Orthopaedic Studio exports its Excel data into a ‘.csv’ file instead of an ’.xls’ file. The ’.csv’ 
file is fully compatible with Excel and can be opened by double-clicking the file in a Finder window.
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1.4 Update log

Version 1.0.0

- Initial release

Version 1.1.0

- Added short keys for starting the plugin (Shift-Ctrl-A for AP, Shift-Ctrl-F for Frog, Shift-Ctrl-V for Von 
Rosen, Shift-Ctrl-P for False Profile).

- No longer necessary to manually close the plugin window before changing between evaluation 
modes.

- Save file has been reorganized. Every evaluation is now placed on a new line.
- Labels for markers are not shown while they are initially being placed.
- ACE angle can now be negative.
- Tönnis angle can now be negative.
- Instructions for placing marker on pubic symphysis has been updated.

Version 1.2.0

- Added support for evaluation of SCFE patients
- License manager included in plugin
- Several minor improvements

Version 1.2.1

- Added support for Mac OS X 10.7
- Added a help button from within the plugin
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2. Description of measured parameters

2.1 Anteroposterior visual scores

2.1.1 Break in Shenton’s line

There is an imaginary line connecting the medial aspect 
of the femoral neck to the superior pubic ramus. It is used 
to determine the relationship/alignment of the head of the 
femur to the acetabulum. 

Observe the alignment of the femur and pelvis and 
determine if they align in an approximately smooth arc.
If the curve is “broken” by more than 5mm then Shenton’s 
line is said to have a break. Interruption of the curve 
occurs with sublaxation or dislocation of the hip.

Reference: Siebenrock, K.A., D.F. Kalbermatten, and R. 
Ganz, Effect of pelvic tilt on acetabular retroversion: a study of pelves from cadavers. Clin Orthop 
Relat Res, 2003(407): p. 241-8.

2.1.2 Cross-over sign

A hip with a normal pelvic inclination should have the 
anterior and posterior lips join at the edge of the 
acetabulum. If a cross is formed by the radiographic 
projections of the anterior and posterior lips then the hip 
is positive for “cross-over sign”.

Reference: Reynolds, D., J. Lucas, and K. Klaue, 
Retroversion of the acetabulum. A cause of hip pain. J 
Bone Joint Surg Br, 1999. 81(2): p. 281-8.

!
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2.1.3 Posterior wall sign

If the posterior wall of acetabulum is medial to the center 
of the femoral head then hip is positive to ”posterior wall 
sign”

Reference: Reynolds, D., J. Lucas, and K. Klaue, 
Retroversion of the acetabulum. A cause of hip pain. J 
Bone Joint Surg Br, 1999. 81(2): p. 281-8.

2.1.4 Tönnis classification

A subjective categorization of the presence of osteoarthritis in the hip joint. The classification involves 
four categories with the following criterion:

Grade 0: Normal, no degenerative changes, no signs of OA
Grade 1: Subchondral Sclerosis, minimal JS narrowing, and minimum formation of osteophytes
Grade 2: Hips with subchondral cyst formation and moderate JS narrowing
Grade 3: Hips with severe or complete but localized JS narrowing
Grade 4: Hips that have undergone extensive or severe cartilage loss. 

Reference: Clohisy, J.C., et al., A systematic approach to the plain radiographic evaluation of the 
young adult hip. J Bone Joint Surg Am, 2008. 90 Suppl 4: p. 47-66.

2.2 Anteroposterior quantitative measurements

2.2.1 LCE (Lateral Center Edge) angle

The angle formed between the two lines passing through the center of the 
femoral head, one of which extends to the lateral edge of sourcil (A) and the 
line perpendicular (B) to that joining the centers of the two femoral heads (of 
the two hips). The normal angle of an adult is greater than 25º. Beyond 40º 
may indicate pincer impingement.

Reference: Wiberg, G., Studies on dysplastic acetabula and congenital 
subluxation of the hip joint. Acta Chir Scand, 1939(58 (suppl)): p. 5-135.
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2.2.2 Tönnis angle

The angle formed by the intersection of horizontal line connecting the femoral 
head centers and the line that passes through medial edge of the sourcil. 
Normal is 0º-10º, less than 0º indicates risk of impingement and higher than 
10º indicates structural instability.

Reference: Clohisy, J.C., et al., A systematic approach to the plain 
radiographic evaluation of the young adult hip. J Bone Joint Surg Am, 2008. 
90 Suppl 4: p. 47-66.

2.2.3 Joint space width

The smallest distance between the femoral head and the acetabulum. The distance should normally 
be 3-5mm. Smaller distance than 3mm, or a distance that is smaller than that of the opposite hip, 
indicates radiological osteoarthritis.

Reference: Fredensborg N, Nilsson BE. The joint space in normal hip radiographs. Radiology 
1978;126:325-6

2.2.4 Pelvic tilt and rotation

Distance between public symphysis and the tip of coccyx (i.e. pelvic tilt) should be 1–3 cm. Tip of 
coccyx should be in line with public symphysis (i.e. pelvic rotation should be low).

Reference: Siebenrock, K.A., D.F. Kalbermatten, and R. Ganz, Effect of pelvic tilt on acetabular 
retroversion: a study of pelves from cadavers. Clin Orthop Relat Res, 2003(407): p. 241-8.

!
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2.3 Von Rosen visual scores

2.3.1 Joint Congruity

Visual classification of joint congruency. Can be used both with images 
taken in the Von Rosen position and standard standing AP position. 

Excellent - if the curvature of the acetabulum and that of the femoral 
head are almost identical and the joint space is adequately maintained. 
Good - if the curvature of the acetabulum and the femoral head are not 
identical but the joint space is adequately maintained.
Fair - if partial narrowing of the joint space has occurred.
Poor - if partial disappearance of joint space has occurred.

Reference: Yasunaga, Y., et al., Rotational acetabular osteotomy in 
patients forty-six years of age or older: comparison with younger 
patients. J Bone Joint Surg Am, 2003. 85-A(2): p. 266-72.

2.4 False profile quantitative measurements

2.4.1 ACE (Anterior Center Edge) angle

A measure to determine the anterior coverage of the 
femoral head and to diagnose arthritis affecting the 
anterior part of the joint.

The ACE angle is measured on images in the false 
profile projection and is defined as the angle between 
an imagined vertical line and the line that extends 
from the center of the femoral head to the lateral edge 
of the sourcil. An ACE angle less than 20º is indicative 
for structural instability.

Reference: Lequesne, M.G. and J.D. Laredo, The 
faux profil (oblique view) of the hip in the standing 
position. Contribution to the evaluation of 
osteoarthritis of the adult hip. Ann Rheum Dis, 1998. 
57(11): p. 676-81.
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2.5 Frog image quantitative measurements

2.5.1 Alpha angle

The alpha angle is the angle between two lines 
originating in the center of the femoral head. One line 
extends out through the center of the femoral neck 
and the other line extends out through the point 
where the radius of the head starts to increase 
compared the central aspect (i.e. where the femoral 
head extends out of its boundary circle).

An alpha angle beyond 55º indicates cam 
impingement.

Reference: Notzli, H.P., et al., The contour of the 
femoral head-neck junction as a predictor for the risk 
of anterior impingement. J Bone Joint Surg Br, 2002. 
84(4): p. 556-60.

2.5.2 Alpha angle for SCFE patients

Due to the translation of the femoral head in SCFE (slipped capital femoral 
epiphysis) patients, a modified alpha angle is sometimes preferred instead of  
the ordinary alpha angle. The modification means that the line drawn through 
the femoral neck does not have to also go through the center of the femoral 
head. Instead, this line should just be set parallel to the femoral neck.

Reference: Leunig, M., et al, In Situ Pinning With Arthroscopic Osteoplasty 
for Mild SCFE, Clin Orthop Relat Res, 2010. 468: p.3160–67

 
2.5.3 Head-neck offset ratio

The head-neck offset ratio is calculated as the 
distance between lines A and B, divided by the 
diameter of the femoral head, C. Line A extends 
through the anteriormost aspect of the femoral neck, 
while line B extends through the anteriormost aspect 
of the femoral head. Both lines are parallel to the long 
axis of the femoral neck. An offset ratio that is less 
than 0.17 indicates that cam deformity is likely.

Reference: Peelle, M.W., et al., Acetabular and 
femoral radiographic abnormalities associated with 
labral tears. Clin Orthop Relat Res, 2005. 441: p. 
327-33.
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2.5.4 Southwick angle

The Southwick angle is of interest in determining the amount of 
correction required for SCFE (slipped capital femoral epiphysis) 
cases. It is defined as the angle between lines A and B, where line 
A extends in the direction of the femoral shaft and line B is 
perpendicular to line C, which connects the edges of the slipped 
epiphysis.

Reference: Southwick, W.O., Osteotomy through the Lesser 
Trochanter for Slipped Capital Femoral Epiphysis, J Bone Joint 
Surg Am, 1967. 49: p.807-35.

2.5.5 Epiphysiseal-metaphyseal offset

The epiphyseal-metaphyseal offset is measured as the distance between a 
line drawn along the anterior edge of the epiphysis parallel to the femoral 
neck and a line drawn along the proximal-anterior edge of the metaphysis 
also parallel to the femoral neck.

Reference: Leunig, M., et al, In Situ Pinning With Arthroscopic Osteoplasty 
for Mild SCFE, Clin Orthop Relat Res, 2010. 468: p.3160–67
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3. Disclaimer

The Orthopaedic Studio software and its documentation is provided as is. Use the software and its 
documentation at your own risk. The software does not have an FDA clearance and is therefore 
restricted to investigational use.

NEITHER THE AUTHOR NOR SPECTRONIC MAKE ANY WARRANTIES AS TO PERFORMANCE 
OR FITNESS FOR A PARTICULAR PURPOSE, OR ANY OTHER WARRANTIES WHETHER 
EXPRESSED OR IMPLIED. NO ORAL OR WRITTEN COMMUNICATION FROM OR INFORMATION 
PROVIDED BY THE AUTHOR OR SPECTRONIC SHALL CREATE A WARRANTY. UNDER NO 
CIRCUMSTANCES SHALL THE AUTHOR OR SPECTRONIC BE LIABLE FOR DIRECT, INDIRECT, 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE, MISUSE, 
OR INABILITY TO USE THE SOFTWARE, EVEN IF THE AUTHOR OR SPECTRONIC HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

ORTHOPAEDIC STUDIO IS NOT INTENDED FOR PRIMARY DIAGNOSTICS.

All calculations, measurements and images provided by this software are intended for investigational 
use only.

If you use Orthopaedic Studio for scientific research please give appropriate credit in publications.
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